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Pourquoi devez-vous de gérer vos polices?
Vos polices sont vos outils ; il vous est utile de savoir où elles se trouvent, et de savoir quand 
et comment les utiliser. Si vous avez une grande collection de polices, une gestion efficace 
de ces polices est primordiale.

• L’installation de vos polices dans le dossier Polices, rend fastidieuse la navigation 
dans les menus polices de vos applications

• Plusieurs projets peuvent utiliser différentes versions de la même police
• L’installation de nouvelles applications peut entraîner des modifications inopinées 

de vos polices
• Vous pouvez perdre un temps précieux en remplaçant les polices endommagées ou 

manquantes ou en éliminant les doublons

La version révisée du Guide des bonnes pratiques de gestion des polices sous Windows vous offre 
la seule information dont vous avez besoin pour garder vos polices sous contrôle. Ce guide couvre 
Windows 7 et Windows 10.

Les meilleures pratiques pour une gestion efficace des polices
• Sauvegarder vos fichiers
• Vérifier les mises à jour pour le système d’exploitation et les applications
• Nettoyer les polices de votre système d’exploitation
• Repérer les polices endommagées ou incompatibles
• Mettre à niveau les anciennes polices
• Résoudre le problème des polices en double
• Ajouter des polices à un gestionnaire de polices
• Créer une règle pour gérer vos polices
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À propos de ce guide
Ce guide regroupe des conseils et informations pour vous aider à comprendre comment gérer vos 
polices sous Windows. Il contient :

• L’organisation de vos polices
• Le traitement des polices anciennes, endommagées ou en double
• L’organisation des polices à l’aide de Suitcase Fusion
• La planification de l'utilisation de nouvelles polices

Conventions utilisées dans ce guide
Gras (Bold)

Indique les nouveaux termes et titres des sections du guide.

Italique (Italic)
Indique les URL et chemin d’accès dossier, les noms de dossiers et de fichiers et les extensions 
de fichiers.

Gras-Largeur fixe(Fixed-width bold)
Affiche les commandes qui doivent être saisies avec exactitude.

Les commandes de menu sont marquées par un crochet droit après le nom du menu (Édition > Tout 
sélectionner (Edit > Select All)). Les commandes de menu dans les sous-menus sont marquées par un 
crochet droit après le nom du sous-menu (Affichage > Trier par > Nom (View > Arrange By > Name)).

Les chemins d’accès commençant par une lettre de lecteur sont des chemins d’accès locaux 
(C:\Windows\Polices\). Les chemins d’accès commençant par deux barres obliques sont 
des chemins d’accès au réseau (\NomServeur\NomPartage\Dossier\). Les chemins d’accès 
qui ne commencent pas par une barre oblique, sont des chemins d’accès relatifs (Aller à 
Polices Accessoires\Polices Office\ (Optional Fonts\Office Fonts\) sur votre bureau).

Un chemin d’accès se terminant par un dossier finira par une barre oblique (C:\Utilisateurs\ 
Administrateur\) ; au contraire d’un chemin d’accès se terminant par un nom de fichier 
(C:\Windows\Polices\Calibri.ttf).

Les étapes qui requièrent d’appuyer sur la touche logo (ou touche Windows) indiqueront le logo 
Windows pour les combinaisons de touches du clavier ( + E). Les étapes qui se réfèrent au menu 
Démarrer utiliseront le nom du menu.

Les instructions données dans ce guide présupposent que votre compte utilisateur Windows est un 
compte Administrateur sur votre PC. Vous pourrez exécuter les actions préconisées dans ce guide si 
vous êtes un utilisateur enregistré, mais quelques actions vous demanderont l’identifiant et le mot 
de passe d’un compte administrateur.
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Collecter vos polices
Gérer vos polices signifie les regrouper et les examiner pour trouver celles qui sont endommagées, 
incompatibles ou en double. Ces étapes sont les mêmes que vous démarriez sur un nouveau PC 
Windows tout neuf, ou que vous travailliez sur un système de production qui utilise une autre 
installation de polices et de logiciel.

Sauvegarder vos fichiers
Avant de commencer un projet qui entraîne des modifications sur votre PC, vous devez sauvegarder 
vos fichiers importants, au cas où une erreur se produirait. Concernant un logiciel de sauvegarde 
tiers, veuillez consulter la documentation.

Vous pouvez créer un point de restauration dans Windows. Si une erreur se produit, vous 
pourrez rétablir votre système Windows au point de restauration et repartir de ce point. Pour plus 
d’indications, se reporter à l’Annexe A : Travailler avec les Points de restauration de Windows 
surpage 16.

Vérifier les mises à jour pour le système d’exploitation et les applications
Vous devez également vous assurer que votre système d’exploitation et les applications sont à jour. 
Les mises à jour peuvent ajouter, actualiser ou supprimer des polices système.

Windows 7 : Cliquez sur Démarrer (Start), puis sélectionner Panneau de configuration (Control 
Panel). Sélectionnez Mises à jour Windows (Windows Update) ; si aucune mise à jour n’est 
disponible, cliquez sur Rechercher les mises à jour (Check for updates) pour vérifier.

Windows 10 : Cliquez sur Démarrer (Start), puis sélectionnez Paramètres (Settings). Sélectionnez 
Mise à jour et sécurité (Updates & Security) ; si aucune mise à jour n’est disponible, cliquez sur 
Rechercher les mises à jour (Check for updates) pour vérifier.

La plupart des applications installent par elles-mêmes leurs mises à jour. Consulter la documentation 
pour ces applications.

Afficher les extensions de fichiers
Lorsque vous travaillez avec les polices, il faut que vous sachiez différencier les fichiers des polices : 
Garamond.ttf et Garamond.otf peuvent avoir des fonctionnalités et glyphes différents. Afin de faciliter 
cette différenciation, vous devez activer les extensions de fichier dans l’Explorateur de fichier.

Windows 7 : Appuyez sur  + E pour ouvrir une fenêtre d’Explorateur et sélectionnez Organiser 
> Dossiers (Organize > Folder) et Options de recherche. Cliquez sur l’onglet Afficher (View tab) 
dans la fenêtre Options (Folder Options) de dossiers et décochez la case marquée Masquer les 
extensions pour les types de fichiers connus, ensuite cliquez sur OK.

Windows 10 : Appuyez sur  + E pour ouvrir une fenêtre d’Explorateur (File Explorer). Cliquez sur 
l’onglet Affichage (View tab) en haut du ruban, ensuite cochez la case Extensions de noms de fichiers 
(File name extensions) dans la section Afficher/Masquer (Show/Hide).

Ceci affichera les extensions de fichiers de tous vos fichiers, pas uniquement ceux de vos polices : 
.doc ou .docx pour les fichiers, .exe pour les applications et ainsi de suite. Quand vous avez terminé, 
vous pouvez à nouveau masquer les extensions des noms de fichiers.
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Modifier les Paramètres d’Affichage pour le dossier de polices
Si vous ouvrez C:\Windows\Fonts\ (C:\Windows\Polices\) dans l’Explorateur de fichiers, Windows utilise 
la présentation du Panneau de configuration des polices. Le Panneau de configuration des polices 
facilite la recherche et la prévisualisation de vos polices, mais il rend plus difficile le nettoyage du 
dossier de polices. Vous pouvez changer les paramètres du dossier de polices afin qu’il s’affiche comme 
un dossier normal.

Windows 7 : Cliquez sur Démarrer (Start), puis sélectionnez Tous les programmes > Accessoires 
(Programs > Accessories). Faites un clic droit sur Invite de commandes et sélectionnez 
« Exécuter en tant qu’Administrateur » (Run as administrator) à partir du menu déroulant.

Windows 10 : Faites un clic droit sur Démarrer (Start), puis sélectionnez Invite de commandes 
(Admin).

Windows vous demandera si vous voulez que l’Invite de commandes effectue des changements sur 
votre ordinateur ; cliquez sur Oui (Yes). Quand la fenêtre d’Invite de commandes est ouverte, entrez 
attrib -r -s C:\Windows\Fonts\ (C:\Windows\Polices\) et appuyez sur Entrée. Si ensuite 
vous ouvrez C:\Windows\Fonts\ (C:\Windows\Polices\), l’affichage doit être celui d’un dossier normal.

Pour revenir à l’affichage précédent, ouvrez une fenêtre d’Invite de commandes administrateur, 
saisissez attrib +r +s C:\Windows\Fonts\ (C:\Windows\Polices\), et appuyez sur Entrée.

Nettoyer vos polices système
Ensuite, vous devriez songer à supprimer les polices inutiles de votre dossier de polices. Sur votre 
bureau, créez un dossier nommé Polices Accessoires (Optional Fonts).

Pourquoi nettoyer les polices système ?
Le fait de conserver de trop nombreuses polices dans votre système peut amener de la confusion 
dans vos menus de vos polices. Les applications créatives se sont améliorées en vous permettant 
de naviguer dans de longues listes de polices, il est néanmoins souvent pénible de trouver les 
polices dont vous avez besoin.

Répertorier vos polices système
Vous pouvez classer les polices de votre ordinateur en différentes catégories :

• Polices installées par Windows
• Les polices de tiers, comprenant les polices installées par Adobe et d’autres applications

Conserver les polices essentielles du système
Microsoft dispose d’une base de connaissances, qui répertorie les polices installées par défaut dans 
Windows, classées selon leur version. Chaque version de Windows installe des polices différentes, 
et la liste des polices installées pour chaque version est différente.

• Windows 7 : Liste des polices Windows 7
• Windows 10 : Liste des polices Windows 10

Collecter les polices à partir d’Adobe Creative Suite & Creative Cloud
Adobe Creative Suite 6 n’est pas pris en charge par Windows 10, mais la désinstallation de Creative 
Suite 6 a pu laisser des polices dans C:\Windows\Fonts\ (C:\Windows\Polices\). Pour plus d’informations, 
se reporter à Polices incluses avec Adobe’s Creative Suite 6. Créez un dossier nommé Polices Adobe dans 
votre dossier Polices accessoires, et déplacez toutes les polices Adobe que vous pourrez trouver, vers votre 
dossier Polices Adobe.
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AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARIALUNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

BROADW.TTF

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

Adobe Creative Cloud n’installe plus de polices dans votre dossier de polices système. Creative Cloud 
utilise les polices Adobe (précédemment connues comme TypeKit), pour répartir ses polices  ; pour 
plus de précisions, se reporter à la FAQ sur les polices de Creative Cloud.

Collecter les polices à partir de Microsoft Office
Créez un dossier nommé Polices Office dans votre dossier Polices accessoires. 

Microsoft Office 2010
Les polices suivantes sont installées par Microsoft Office 2010 sous Windows 7 :
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GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF

LBRITE.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MTCORSVA.TTF

NIAGENG.TTF

NIAGSOL.TTF

OCRAEXT.TTF

OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

ROCKBI.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Déplacez ces polices vers votre dossier Polices Office (Office Fonts).
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Microsoft Office 2013
Les polices suivantes sont installées par Microsoft Office 2013 sous Windows 7 et Windows 10 :

AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARIALUNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

BROADW.TTF

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF
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LBRITE.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MSUIGHUB.TTF

MTCORSVA.TTF

NIAGENG.TTF

NIAGSOL.TTF

OCRAEXT.TTF

OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

ROCKBI.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Les polices suivantes sont installées par Microsoft Office 2013 uniquement sous Windows 7 :

GADUGI.TTF

GADUGIB.TTF

MSJH.TTC

MSJHBD.TTC

MSYH.TTC

MSYHBD.TTC

NIRMALA.TTF

NIRMALAB.TTF

SEGOEUISL.TTF

Les polices suivantes sont installées par Microsoft Office 2013 uniquement sous Windows 10 :
LEELAWAD.TTF

LEELAWDB.TTF

MSUIGHUR.TTF

Déplacez ces polices vers votre dossier Polices Office (Office Fonts).
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AGENCYB.TTF

AGENCYR.TTF

ALGER.TTF

ANTQUAB.TTF

ANTQUABI.TTF

ANTQUAI.TTF

ARIALN.TTF

ARIALNB.TTF

ARIALNBI.TTF

ARIALNI.TTF

ARLRDBD.TTF

BASKVILL.TTF

BAUHS93.TTF

BELL.TTF

BELLB.TTF

BELLI.TTF

BERNHC.TTF

BKANT.TTF

BODB.TTF

BODBI.TTF

BODBLAI.TTF

BODBLAR.TTF

BODCB.TTF

BODCBI.TTF

BODCI.TTF

BODCR.TTF

BODI.TTF

BODPSTC.TTF

BODR.TTF

BOOKOS.TTF

BOOKOSB.TTF

BOOKOSBI.TTF

BOOKOSI.TTF

BRADHITC.TTF

BRITANIC.TTF

BRLNSB.TTF

BRLNSDB.TTF

BRLNSR.TTF

BROADW.TTF

Microsoft Office 2016
Les polices suivantes sont installées par Microsoft Office 2016 sous Windows 7 et Windows 10 :

BRUSHSCI.TTF

BSSYM7.TTF

CALIFB.TTF

CALIFI.TTF

CALIFR.TTF

CALIST.TTF

CALISTB.TTF

CALISTBI.TTF

CALISTI.TTF

CASTELAR.TTF

CENSCBK.TTF

CENTAUR.TTF

CENTURY.TTF

CHILLER.TTF

COLONNA.TTF

COOPBL.TTF

COPRGTB.TTF

COPRGTL.TTF

CURLZ.TTF

ELEPHNT.TTF

ELEPHNTI.TTF

ENGR.TTF

ERASBD.TTF

ERASDEMI.TTF

ERASLGHT.TTF

ERASMD.TTF

FELIXTI.TTF

FORTE.TTF

FRABK.TTF

FRABKIT.TTF

FRADM.TTF

FRADMCN.TTF

FRADMIT.TTF

FRAHV.TTF

FRAHVIT.TTF

FRAMDCN.TTF

FREESCPT.TTF

FRSCRIPT.TTF

FTLTLT.TTF

GARA.TTF

GARABD.TTF

GARAIT.TTF

GIGI.TTF

GILBI.TTF

GILB.TTF

GILC.TTF

GILI.TTF

GILLUBCD.TTF

GILSANUB.TTF

GIL.TTF

GLECB.TTF

GLSNECB.TTF

GOTHIC.TTF

GOTHICB.TTF

GOTHICBI.TTF

GOTHICI.TTF

GOUDOS.TTF

GOUDOSB.TTF

GOUDOSI.TTF

GOUDYSTO.TTF

HARLOWSI.TTF

HARNGTON.TTF

HATTEN.TTF

HTOWERT.TTF

HTOWERTI.TTF

IMPRISHA.TTF

INFROMAN.TTF

ITCBLKAD.TTF

ITCEDSCR.TTF

ITCKRIST.TTF

JOKERMAN.TTF

JUICE.TTF

KUNSTLER.TTF

LATINWD.TTF

LBRITE.TTF

LBRITED.TTF

LBRITEDI.TTF

LBRITEI.TTF
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OLDENGL.TTF

ONYX.TTF

OUTLOOK.TTF

PALSCRI.TTF

PAPYRUS.TTF

PARCHM.TTF

PERBI.TTF

PERB.TTF

PERI.TTF

PERTIBD.TTF

PERTILI.TTF

PER.TTF

PLAYBILL.TTF

POORICH.TTF

PRISTINA.TTF

RAGE.TTF

RAVIE.TTF

REFSAN.TTF

REFSPCL.TTF

ROCCB.TTF

ROCC.TTF

ROCK.TTF

ROCKB.TTF

ROCKBI.TTF

LCALLIG.TTF

LFAX.TTF

LFAXD.TTF

LFAXDI.TTF

LFAXI.TTF

LHANDW.TTF

LSANS.TTF

LSANSD.TTF

LSANSDI.TTF

LSANSI.TTF

LTYPE.TTF

LTYPEB.TTF

LTYPEBO.TTF

LTYPEO.TTF

MAGNETOB.TTF

MAIAN.TTF

MATURASC.TTF

MISTRAL.TTF

MOD20.TTF

MSUIGHUB.TTF

MTCORSVA.TTF

NIAGENG.TTF

NIAGSOL.TTF

OCRAEXT.TTF

ROCKEB.TTF

ROCKI.TTF

SCHLBKB.TTF

SCHLBKBI.TTF

SCHLBKI.TTF

SCRIPTBL.TTF

SHOWG.TTF

SNAP.TTF

STENCIL.TTF

TCBI.TTF

TCB.TTF

TCCB.TTF

TCCEB.TTF

TCCM.TTF

TCMI.TTF

TCM.TTF

TEMPSITC.TTF

VINERITC.TTF

VIVALDII.TTF

VLADIMIR.TTF

WINGDNG2.TTF

WINGDNG3.TTF

Les polices suivantes sont installées par Microsoft Office 2016 uniquement sous Windows 10 :
LEELAWAD.TTF

LEELAWDB.TTF

MSUIGHUR.TTF

Les polices suivantes sont installées par Microsoft Office 2016 uniquement sous Windows 7 :
GADUGI.TTF

GADUGIB.TTF

MSJH.TTC

MSJHBD.TTC

MSYH.TTC

MSYHBD.TTC

NIRMALA.TTF

NIRMALAB.TTF

SEGOEUISL.TTF

Déplacez ces polices vers votre dossier Polices Office (Office Fonts).
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Nettoyer et organiser vos polices
Repérer les polices endommagées ou incompatibles
Au fil du temps, vous pourriez rencontrer des problèmes avec vos polices.

• Les polices peuvent être endommagées quand vous les déplacez d’un ordinateur à un autre
• Les anciens formats des polices ne sont pas pris en charge par les versions récentes de Windows
• Les anciennes polices peuvent contenir des métadonnées internes incohérentes de polices, 

ou d’autres bugs. Les polices sont aussi des logiciels !

Vous pouvez analyser vos polices avec FontDoctor pour vérifier si elles sont endommagées ou 
incompatibles. Suitcase Fusion analyse automatiquement les polices et recherche d’éventuels problèmes 
quand vous les ajoutez à la bibliothèque de polices.

Extensis inclut une copie gratuite de FontDoctor quand vous achetez Suitcase Fusion.
FontDoctor peut également être acheté séparément.

Scannez vos polices avec FontDoctor
FontDoctor scanne les polices et recherche d’éventuels problèmes comme les formats de polices 
incompatibles, les polices endommagées ou incomplètes et les polices en doublon.

1. Ouvrez FontDoctor
2. À partir du Finder, faites glisser le dossier de polices que vous voulez analyser, et déposez-le 

dans la fenêtre de FontDoctor

FontDoctor va alors créer un rapport des problèmes qu’il a trouvés et peut mettre en quarantaine les polices 
problématiques. Pour plus de précisions sur les options des offres FontDoctor, sélectionnez Aide > Afficher Aide.

Mise à niveau d’anciennes polices aux nouveaux formats
Il n’est pas toujours aisé de remplacer les polices que vous utilisez, particulièrement lors d’un travail sur 
un document que vous n’avez pas créé. Il existe de bonnes raisons pour passer à l’utilisation de polices 
OpenType (ou TrueType, si les versions OpenType ne sont pas disponibles) :

• Vous pouvez utiliser les polices OpenType et Windows TrueType aussi bien sous Mac OS que sous 
Windows

• Les polices PostScript de Type 1 sont propres au SE ; les glyphes pourraient être mappés vers 
des caractères différents et il en résulterait des erreurs d’affichage lors des changements entre 
deux plateformes

• OpenType est le format le plus récent pour les polices, offrant des fonctionnalités que les polices 
de Type 1 et TrueType ne possèdent pas

• Aujourd’hui, la plupart des fonderies types produisent uniquement des versions OpenType 
de leurs polices

Vous pouvez conserver les anciennes polices traditionnelles dans votre gestionnaire de polices et les 
activer selon les besoins pour des projets plus anciens. La plupart des fonderies facturent les nouvelles 
versions de polices, mais vous pouvez vérifier s’il existe des mises à niveau gratuites.

Identifier les polices en double
Les polices en double sont une plaie en matière de gestion des polices.

Vous pourriez avoir plus d’un exemplaire de la même police. Vous l’avez peut-être téléchargée plus 
d’une fois, ou ajoutée au système d’exploitation sans avoir supprimé l’original. Cela se résout aisément : 
sélectionnez l’exemplaire que vous souhaitez conserver et supprimez les autres.
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Le principal problème concerne les polices qui ont les mêmes caractéristiques, telles que celles de Helvetica 
ou Garamond, tout en n’étant pas des copies conformes. Vous pouvez avoir des versions TrueType et 
OpenType de vos polices. Vous pouvez avoir deux versions différentes de la même police ; la plus récente 
pourrait comporter plus de glyphes, d’ajustements de crénage et d’espacement de ligne, ou de nouvelles 
fonctionnalités OpenType, telles que des ligatures personnalisées.

Si vous avez des polices en double, il est probable que vous ayez utilisé différentes versions dans différents 
projets. Si vous débarrassez de la version montrée dans l’exemple à gauche, vous pouvez vous retrouver 
avec un projet ressemblant à l’exemple à droite : les retours à la ligne automatiques du texte sont différents, 
ce qui occasionne des différences de reflux et de pagination.

   
L’utilisation de Suitcase Fusion pour gérer les polices en double est abordée dans Gérer vos polices avec 
Suitcase Fusion surpage 13.

Repérer les polices en double avec FontDoctor
FontDoctor peut repérer et mettre en quarantaine les polices doublons.

1. Ouvrez FontDoctor
2. Pour que FontDoctor analyse un dossier de polices, faites glisser l’icône du dossier à partir du 

Finder, puis déposez-la sur la fenêtre de FontDoctor

Si FontDoctor trouve plus d’une police ayant le même nom PostScript et format de police, il met en 
quarantaine la version la plus ancienne et conserve la version la plus récente. Si vous voulez que 
FontDoctor conserve automatiquement toutes les versions d’une police :

1. Cliquez sur Paramètres (Settings)
2. Pour Trouver les polices en double, cliquez sur Options Diagnostic Avancé (Advanced Diagnosis Options)
3. Assurez-vous que la case Autoriser plusieurs versions de la même police (Allow Multiple Versions of the Same 

Font), soit cochée

Le Nom PostScript d’une police est une partie de métadonnées que Windows et des applications utilisent 
pour reconnaître les polices. Il peut être différent du nom de fichier de la police et du nom d’affichage 

de la police. Vous lisez le nom d’affichage d’une police dans le menu polices de l’application, 
ou dans une boîte de dialogue.
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 Gérer vos polices avec Suitcase Fusion
Après avoir collecté et nettoyé vos polices, vous êtes prêt à les ajouter à Suitcase Fusion. Cette partie aborde 
les manipulations de base pour ajouter et gérer ses polices ; pour plus d’indications sur l’utilisation de 
Suitcase Fusion, sélectionnez Aide > Aide Suitcase Fusion (Help > Suitcase Fusion Help).

Ajouter vos polices
Ajouter vos polices à Suitcase Fusion :

1. Sélectionnez Fichier > Ajouter des polices à la bibliothèque (File > Add Fonts to Library)
2. Recherchez votre dossier Polices accessoires (Optional Fonts) sur votre bureau et cliquez sur Ajouter (Add)

Suitcase Fusion créera un jeu de polices appelé « Polices accessoires » et ajoutera les polices à ce jeu. 
Vous pouvez également faire glisser les dossiers de Polices accessoires (Optional Fonts) vers la Bibliothèque 
de polices dans la barre latérale de la fenêtre principale de Suitcase Fusion. Suitcase Fusion créera un jeu 
pour chaque dossier et ajoutera les polices à ces jeux.

Ajouter des polices aux Polices temporaires
Quelques projets ne demandent pas à ce que les polices soient ajoutées définitivement à votre bibliothèque 
de polices. Vous pouvez les faire glisser vers le dossier Polices temporaires dans la barre latérale de Suitcase 
Fusion, ou bien les faire glisser et les déposer sur l’icône Dock de Suitcase Fusion. Les polices du dossier Polices 
temporaires sont supprimées quand vous déconnectez de Windows, ou quand vous redémarrez votre PC.

Remarque : Les polices qui sont temporairement ajoutées, ne sont pas copiées dans le Coffre ; elles sont 
ajoutées sur place. Si vous déplacez un dossier de polices après les avoir ajoutées à Polices temporaires, 
Suitcase Fusion ne pourra pas les utiliser.

Créer et Supprimer des jeux
Après avoir ajouté vos polices, vous pouvez supprimer les jeux que vous avez créés, si vous souhaitez 
les organiser différemment. Sélectionnez un jeu et sélectionnez Édition > Supprimer un jeu (Edit > 
Delete Set) … pour supprimer un jeu.

Pour créer un jeu, sélectionnez Fichier > Nouveau jeu (File > New Set) et donnez-lui un nom. Pour ajouter des 
polices à un jeu, sélectionnez-les à partir de la bibliothèque de polices et faites-les glisser sur le nom du jeu.

Gestion des Polices en double
Si vous avez ajouté des polices à Suitcase Fusion, avec le temps, vous pouvez découvrir que vous avez des 
doublons de certaines de vos polices. Suitcase Fusion ne vous permet pas d’ajouter la même police au 
Coffre plus d’une fois ; il ajoutera la police avec différents numéros de version ou formats de police.

La plupart du temps, vous désirez utiliser les mêmes polices que celles de documents anciens, 
ou de projets créés par d’autres personnes, sur lesquels vous travaillez. Si ce n’est le cas, vous voudrez 
peut-être supprimer les versions les plus anciennes et les anciens formats afin d’être sûr d’utiliser 
d’utiliser les versions de vos polices plus récentes.

1. Ouvrez Suitcase Fusion
2. Dans la section de recherche intelligente Smart Search de la barre latérale, cliquez sur Polices 

Doublons (Duplicate Fonts)

L’écran affiche les polices qui portent le même nom PostScript. Si les polices sont regroupées par famille, 
vous pouvez afficher la police indépendamment en décochant Vue > Grouper les polices par famille 
(View > Group Fonts by Family).

Vous pouvez choisir des polices et sélectionner Édition > Supprimer (Edit > Delete) (ou appuyer sur la 
touche Suppr) pour les supprimer de votre Bibliothèque de polices. Ceci les supprime du Coffre de polices, 
assurez-vous d’avoir sauvegardé des copies !
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Créer une règle pour l’avenir
Vous avez nettoyé les dossiers de polices du système d’exploitation ; vous êtes débarrassé des polices 
inutiles et vous les avez ajoutées à Suitcase Fusion, ou à un autre gestionnaire de polices. À présent, 
il est temps de créer une règle pour aller plus loin.

Organiser ses polices avec FontDoctor
Vous pouvez conserver vos polices dans les dossiers Polices accessoires (Optional Fonts)  que vous avez 
créés. Vous pouvez également les organiser en familles de polices afin de faciliter les recherches. 
FontDoctor peut organiser un dossier de polices en une nouvelle structure de dossier.

1. Ouvrez FontDoctor
2. Dans Analyser & Organiser (Scan & Organize), cliquez sur Afficher Options (Show Options)
3. Sélectionnez le dossier que vous voulez organiser
4. Sélectionnez le dossier dans lequel vous voulez placer les polices organisées en
5. Choisissez comment vous voulez trier et regrouper vos polices, ensuite cliquez sur Démarrer 

l’analyse (Start Scan)

FontDoctor analysera vos polices et les triera par groupes de dossiers. Vous pouvez utiliser le même 
dossier de destination plusieurs fois, pour associer toutes vos polices en une collection.

Sauvegarder vos polices
Le moyen le plus rapide pour sauvegarder vos polices, est de les sauvegarder en même temps que vos 
autres fichiers. Si vous utilisez déjà un logiciel de sauvegarde tiers, c’est idéal ! Assurez-vous que vos 
polices sont dans l’un des dossiers à sauvegarder. Vous pouvez les compresser en les archivant dans 
un fichier .zip en effectuant un clic droit sur l’icône du dossier, puis en sélectionnant Envoyer vers > 
Dossier compressé (zip) (Send to > Compressed (zipped)).

Vous pouvez également faire une sauvegarde du Coffre de polices Suitcase Fusion. Sélectionnez 
Fichier > Archiver Coffre de polices > Archiver (File > Font Vault Archive > Archive)… et sélectionnez 
l’emplacement pour le fichier de sauvegarde. Suitcase Fusion crée un fichier avec une extension 
.winbackup et sauvegarde la totalité du Coffre de polices : polices, jeux et métadonnées personnalisées. 
Ensuite, assurez-vous d’avoir stocké le fichier de sauvegarde dans un emplacement sûr.

Suitcase Fusion dispose également de TypeSync, une fonctionnalité de synchronisation qui copie 
votre Coffre de polices sur le Cloud. Si vous connectez à une nouvelle copie de Suitcase Fusion, vos 
polices et les jeux seront automatiquement ajoutés à votre Coffre de polices. Pour plus de précisions 
sur TypeSync, sélectionnez Aide > Aide Suitcase Fusion (Help > Suitcase Fusion Help).

Si vous utilisez un autre gestionnaire de polices, vérifiez dans la documentation pour savoir s’il existe 
une fonctionnalité qui permet de faire une sauvegarde de votre collection de polices.

Obtenir de nouvelles polices
Ne nous leurrons pas, nous n’avons jamais trop de polices. À un certain moment, vous aurez besoin 
de polices supplémentaires, ce que vous devez savoir au préalable, c’est ce que vous allez en faire.

Sous Windows 10, vous pouvez acheter des polices sur Windows Store. Les polices achetées via la 
boutique Microsoft Store ne sont pas conservées dans C:\Windows\Fonts\ (C:\Windows\Polices\), 

et certaines des applications Windows ne peuvent pas les déceler.
Pour plus d’informations, se reporter à Nouvelles polices « Pro » sous Windows 10.
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Acheter de nouvelles polices
En achetant de nouvelles polices, vous devez penser à certains points :

• Achetez vos polices sur des sites Internet ou auprès de fonderies de renom et reconnus 
comme fiables

• Assurez-vous que les polices incluent les styles, les langues et les symboles dont vous avez besoin
• Essayez d’obtenir des polices au format OpenType, ou au format TrueType si les polices en OpenType 

ne sont pas disponibles
• Évitez les collections d’une multitude de polices à bas prix : la plupart de ces polices afficheront des 

caractères « amusants » que vous utiliserez rarement et qui sont probablement de médiocre qualité 
typographique

Télécharger des polices gratuites
Soyez vigilant quand vous téléchargez des polices à partir de sites Internet de « polices gratuites ». Il 
existe des fournisseurs renommés qui offrent des polices gratuites, comme Apple, Adobe, Microsoft et 
Monotype. Si vous avez l’intention d’utiliser des polices gratuites, téléchargez-les à partir de sites Internet 
de confiance.

De nombreux sites Internet de « polices gratuites » n’offrent que des polices de qualité médiocre. Parfois les 
polices offertes ne sont que de pâles imitations de polices très communes qui ne disposent pas des glyphes 
et des fonctionnalités offertes par les polices conçues par les professionnels. Ces sites peuvent également 
offrir des copies piratées de polices en vente. En cas de doute, évitez de les utiliser !

Travailler avec des polices installées par les applications
Certaines applications comprennent des polices de haute qualité, pour votre utilisation. Le logiciel 
peut installer ses polices dans vos dossiers polices système, ou dans d’autres emplacements que votre 
gestionnaire de polices ne peut pas gérer. Si vous pensez que votre application a installé de nouvelles 
polices et que vous ne les trouvez pas, consultez la documentation de l’application, ou l’assistance sur 
le site Internet du développeur.

Sur le bureau, créez un dossier nommé d’après l’application (par exemple, Polices Finale). Après avoir 
installé votre application, comparez le contenu de votre dossier polices système avec la liste des polices 
systèmes de votre version de Windows. Vous pouvez déplacer les dernières polices ajoutées vers le dossier 
d’application que vous avez créé sur le bureau ; et à partir de là vous pouvez les ajouter à un gestionnaire 
de polices.

Travailler avec vos nouvelles polices
Si vos polices proviennent d’un fournisseur fiable, il est fort probable que vous ne rencontrerez pas 
de problème. Néanmoins vous pouvez utiliser FontDoctor pour les analyser et détecter tout problème 
éventuel, et les ajouter à votre collection classée par dossiers.

Si vous ajoutez les polices à votre gestionnaire de polices, vous pouvez les ajouter en tant que jeu, de 
manière à les retrouver rapidement par la suite. Si votre gestionnaire de polices vous permet d’ajouter 
à une police des annotations ou des marques, vous pouvez y ajouter des données sur la commande, 
le fournisseur et le client.

Alors ?
Voilà ! Arrivé à ce stade, vous devez avoir : un dossier propre de polices système, vos polices ajoutées au 
gestionnaire de polices et organisées comme vous le souhaitez, des copies de sauvegarde de vos polices en 
cas d’accident et une règle pour gérer vos nouvelles polices. À présent, allez de l’avant et soyez créatif(ive) !
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 Annexe A : Travailler avec les points de restauration 
de Windows
Créer un point de restauration avec Windows
Windows 7 :

1. Cliquez sur le bouton Démarrer (Start button), puis cliquez sur Panneau de configuration 
(Control Panel)

2. Dans le panneau de configuration (Control Panel), cliquez sur Système (System)
3. Cliquez sur Protection système (System protection) dans le volet à gauche ; si vous êtes invité à 

entrer un mot de passe, entrez votre mot de passe administrateur

Windows 10 :

1. Ouvrez le menu Démarrer et sélectionnez Système Windows > Panneau de configuration 
(Windows System > Control Panel)

2. Dans le panneau de configuration (Control Panel), cliquez sur Système (System)
3. Cliquez sur Protection système (System protection) dans le volet à gauche ; si vous êtes invité à 

entrer un mot de passe, entrez votre mot de passe administrateur

Dans la fenêtre des Propriétés Système, allez sur Paramètres de Protection, sélectionnez « Disque local 
(C:)(Système) » (Local Disk (C:)(System)), et cliquez sur Configurer (Configure)… Cliquez sur Restaurer les 
paramètres système et précédentes versions des fichiers (Restore system settings and previous versions of files), 
ensuite cliquez sur OK pour fermer la fenêtre.

Pour créer un point de restauration, cliquez sur Créer (Create)… et saisissez une description du point 
de restauration (telle que « Avant suppression des polices tierces »), puis cliquez sur Créer (Create).

Rétablir le système à partir du point de restauration
Si vous avez créé un point de restauration avant de déplacer les polices de votre dossier polices 
système, vous pouvez rétablir Windows au point de restauration si une erreur se produit.

Windows 7 : Cliquez sur le bouton Démarrer (Start), puis sélectionnez Tous les programmes > 
Accessoires > Outils système > Restauration système (All Programs > Accessories > 
System Tools > System Restore).

Windows 10 : Ouvrir le menu Démarrer (Start Menu) et sélectionnez Système Windows > Panneau 
de configuration (Windows System > Control Panel). Dans le panneau de configuration, cliquez 
sur Restauration (Recovery), puis cliquez sur Ouvrir restauration système (Open System Restore).

Dans l’assistant de restauration du système (System Restore), cliquez sur Suivant (Next) pour afficher 
la liste des points de restauration. Sous Windows 7, si le point de restauration n’apparaît pas, cochez 
la case Afficher plus de points de restauration (Show more restore points). À partir de la liste, sélectionnez 
le point de restauration utile, et ensuite cliquez sur Suivant (Next). Confirmez que le point de 
restauration que vous avez sélectionné est le bon, et ensuite cliquez sur Terminer (Finish).

Windows vous avertira que la restauration est irréversible ; cliquez sur Oui (Yes). Quand la 
restauration de Windows est terminée, votre PC redémarre.
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Extensis
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Extensis Europe
Suites 17 & 18, Newton House
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